
  

 

2020 Knowledge Based Nontraditional Engagements 

April 2020 

CCH® ProSystem fx® Knowledge Coach 

Welcome to 2020 Knowledge-Based™ Nontraditional Engagements for Knowledge Coach 

This document provides important information about the 2020 release of Knowledge Based Nontraditional Engagements. Review this 

information carefully. If you have any questions, additional information is available on CCH Support Online. 

New in this Release  

Knowledge-Based Nontraditional Engagements 

This title can be installed on CCH® ProSystem fx® Engagement v2018 by first installing the CCH ProSystem fx Engagement v2018.2.4 Update 

for Knowledge Coach. The latest update can be downloaded here. This update allows you to use the 2020 content without installing 

Engagement v2019 until your firm plans to update. 

This title is designed to help the auditor efficiently and effectively perform attestation and consulting engagements in accordance with 

applicable standards issued by the American Institute of Certified Public Accountants (AICPA), including Statement on Standards for 

Attestation Engagements (SSAEs) and Statements on Standards for Consulting Services (SSCS) (CS Section 100). The Knowledge-Based 

Methodology for nontraditional engagements is a risk-based methodology conducting nontraditional engagements. It emphasizes using 

knowledge of the entity, subject matter, and suitable criteria to perform procedures, and, when applicable, make risk assessments and 

recommendations in connection with an engagement. 

Nontraditional engagements are often unique and complex, requiring specialized accounting and attestation knowledge. Conducting 

nontraditional engagements requires the exercise of the practitioner’s professional judgment. This edition includes specific up-to-date 

guidance for nontraditional engagements and is published for the purpose of communicating updates and enhancements included in the 

current version to users of the toolset. This document is not, and should not be used as, an engagement program to update the 

documentation of an engagement started in a previous version of this product.  

The methodology is presented in terms of its application for attestation engagements including: 

• Attestation Engagements 

– Examination-Level (General) 

– Review-Level (General) 

• Agreed-Upon Procedures Engagements (General) 

• Prospective Financial Statements 

– Examination-Level Engagements 

– Review-Level Engagements 

 

• Management's Discussion and Analysis 

– Examination-Level Engagements 

– Review-Level Engagements 

• Sustainability Information  

– Examination-Level Engagements  

– Review-Level Engagements  

• Cybersecurity Risk Management Program  

– Examination-Level Engagements  

http://support.cch.com/productsupport/
https://support.cch.com/updates/Engagement/release2018/release2018.aspx
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• Pro Forma Financial Information 

– Examination-Level Engagements 

– Review-Level Engagements 

• Entity's Compliance with Specified Requirements or the 
Responsible Party's Written Assertion 

– Examination-Level Engagements 

– Review-Level Engagements 

• Due Diligence Engagements  

– Consulting Engagements  

• Risk Assessment Engagements  

– Consulting Engagements  

• ElderCare Services Engagements  

– Consulting Engagements 

The forms and practice aids in the knowledge-based methodology will help the practitioner to perform the procedures necessary to 

complete the engagement in accordance with professional standards. The Knowledge-Based tools include documents, attestation 

programs, practice aids, correspondence, and example reports. 

If you are updating from a previous version of this title, refer to the Knowledge Coach User Guide Chapter 12. The guide is found on the 

Engagement File Room Help menu.  

The 2020 documents include CCH® Accounting Research® material links to specific guidance that provides instant access to detailed analysis 

related to the steps and processes discussed in the workpapers.  

2020 Edition of Knowledge-Based Nontraditional Engagements  

This edition features numerous enhancements, including:  

• Combining ATT-401 Understanding Entity-Level Controls: Complex and ATT-401N Understanding Entity-Level Controls: Non-
Complex giving the practitioner the option to memo or complete the detailed table for each section based on tailoring. 

Roll Forward Note: If you have used the noncomplex document in your prior engagement, before rolling that file forward, you must 
add the complex document to your engagement binder to retain the data from the noncomplex document, and then remove this 
workpaper from the prior year binder after you have rolled the binder forward. 
 
If your binder has already been finalized and you don’t want to unfinalize the binder to insert the complex document before you roll 
forward from the 2019 version, make a copy of your finalized binder, insert the applicable complex document, then roll forward the 
copied binder to the 2020 title version. After roll forward, remember to delete the copied prior year binder from your file room. 
Doing this will retain the data in the 2020 combined version.  
 
Alternatively, copy and paste the data from the prior year noncomplex document from the prior year binder after you roll forward 
into the current combined versions. The noncomplex document will roll forward as an obsolete workpaper with no data, and should 
be removed after you have rolled forward your binder. Refer to your prior year binder for data in the noncomplex document.  
 
For the “update knowledge coach content” option, you should insert the complex version of the workpaper prior to updating to 
retain information from the now obsolete noncomplex version. We recommend that you publish the noncomplex version prior to 
using the “update knowledge coach content” option so that the user has access to the dat. After updating, the noncomplex version 
will be obsolete. 
 
By performing an option above, the Relevant Principle tables and Section IV: Conclusion will retain from the noncomplex document 
into the new combined document. This will work the same as the Commercial KBA-401 workpaper. 

• Adding flow of columns “Nature of Other Services” and “Firm Personnel Overseeing the Service” from AID-101 Overall Examination 
Engagement Strategy to AID-201 Nonattest Services Independence Checklist in the Examination and Review Titles. 

• Adding one new column (If Controls are Not Effectively Designed and Implemented or Are Not Operating Effectively, Describe the 
Risks of Material Misstatement) in ATT-402 Understanding General Controls for Information Technology in the “less complex” table 
in the Examination Title. 
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• Adding new subprocesses in ATT-403 Understanding Activity-Level Controls: Revenue, Accounts Receivable, and Cash Receipts 
related to ASC Topic 606 in the Examination Title. 

• Adding new tailoring question in ATT-100 Engagement-Level Tailoring Questions in the Examination Title. See KCO-003 Answer 
Effects for the Engagement Level Tailoring Questions Workpaper for explanation of the functioning of this new tailoring question: Is 
the engagement for the period ending on or after June 30, 2020? 

• Adding two new tailoring questions in ATT-100 Engagement-Level Tailoring Questions in the Agreed-Upon Procedures Title. See 
KCO-003 Answer Effects for the Engagement Level Tailoring Questions Workpaper for explanation of the functioning of these new 
tailoring questions: 

o Is the engagement for the period ending on or after June 30, 2020? 

o Is the engagement performed AFTER implementation of SSAE-19, Agreed-Upon Procedures Engagements? 

• Enhancing instructions, practice points, and procedures throughout the toolset to improve workflow. 

Click here for the 2020 Nontraditional Engagements Title Overview for Knowledge Coach Users. 

In addition, forms and practice aids throughout have been updated to include new examples and tips, and where applicable, to take into 

account new literature, standards, and developments, reflected in the following current audit and accounting guidance:  

• AICPA Auditing Standards Board (ASB) Statements on Standards for Attestation Engagements (SSAE) No. 20, Attestation Standards: 
Amendments to the Description of the Concept of Materiality 

• 2018 Revision of Government Auditing Standards (GAGAS, or the Yellow Book, effective for attestation engagements for periods 
ending on or after June 30, 2020) 

• QC Section 10, A Firm’s System of Quality Control 

• The revised AICPA Code of Professional Conduct (Code), including the provisions of ET Section 1.295, Nonattest Services 

Important: 

• Save changes to workpapers before closing the workpaper or the binder to ensure data updates correctly. 

• If Microsoft® Word crashes when using Knowledge Coach, before closing the binder, use the Save Knowledge Coach Answers 
option in the binder view under the Tools menu. This saves all data within tables. 

• You can view other Knowledge Coach Best Practices on our Web site. 

System Requirements 

This title requires the 2019 Financial Statement Base Title. The 2019 Financial Statement Base title must be installed with one of the 

following versions of CCH® ProSystem fx ® Engagement and Knowledge Coach:  

• Engagement and Knowledge Coach v2018 with CCH ProSystem fx Engagement v2018.2.4 Update or later available here. To identify 
the version you are running, please go to Help > About in the application.  

• Engagement and Knowledge Coach v2019 or newer. 

If you are upgrading from Engagement v7.1 or older, please contact Technical Support. 

A minimum of 4GB of RAM is required for optimal performance when opening and navigating Knowledge Coach workpapers. 

http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2020%20Non-Traditional%20Engagements%20Title%20Overview%20for%20Knowledge%20Coach%20Users.pdf
https://support.cch.com/kb/solution/000034942/sw34947
https://support.cch.com/updates/Engagement/release2018/release2018.aspx
https://support.cch.com/contact
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License Requirements 

This title requires the Knowledge-Based Nontraditional Engagements license. Users who do not have a license for this title cannot use 

Knowledge Coach functionality in workpapers.  

For information on updating your licensing, see How do I add or update CCH ProSystem fx Engagement Licenses? on our Support Web site.  

For more information on assigning licenses, see How do I assign Engagement Licenses? on our Support Web site. 

Download Instructions 

If you plan to use this title on Engagement and Knowledge Coach v2018, apply the CCH ProSystem fx Engagement v2018.2.4 Update to all 

computers, including Admin and terminal servers, before installing the title. Review the update's release notes for more deployment 

information. 

To download this title: 

1. Navigate to the Knowledge Coach Updates section of the Engagement Support Web site.  

2. Select the Knowledge Coach Series. The series are arranged by title type, then industry. 

3. Click Download File next to the title you want to download. 

Note: Occasionally the content package file (KCP) downloads with the file name extension changed to ZIP. If this occurs, change the 

extension of the downloaded file to KCP, using all capital letters. 

You must install the 2019 Financial Statement Base title before installing the 2020 Knowledge Based Nontraditional Engagements.  

The Financial Statement Base title is also available on the Knowledge Coach Update Web site.    

The Knowledge Coach Content Package (KCP) download is a proprietary file that must be installed from within Engagement. Save this KCP 

file to a location on your local drive, and follow the Installation Instructions below. 

Installation Instructions 

See How do I add a new CCH® ProSystem fx® Knowledge Coach title to CCH® ProSystem fx® Engagement? for instructions on installing a 

new Knowledge Coach title. 

Using Your Knowledge Coach Content with CCH® Accounting Research Manager® 

CCH Accounting Research Manager (ARM) is the most comprehensive, up-to-date and objective online database of financial reporting 

literature. It includes all authoritative and proposed accounting, attestation, and SEC literature, plus independent, expert-written 

interpretive guidance.  

Available on ARM, the Knowledge-Based Nontraditional Engagements Guide helps you comply with the most recent professional standards 

and guidance for the conduct of Nontraditional Engagements and to integrate the use of practice aids, tools, and other resources with its 

guidance. This publication supplements and complements the Knowledge-Based documents that are available in Knowledge Coach. 

If you subscribe to an ARM library that includes Nontraditional Engagements content, you can link directly to source material from 

Resources within Knowledge Coach documents. These links have been updated to refer to the accounting standards under the FASB 

Accounting Standards Codifications. Also, if you subscribe to the Knowledge-Based Nontraditional Engagements Guide on ARM, you can 

take advantage of references to the guide material from within the Knowledge Coach documents.  

https://support.cch.com/kb/solution.aspx/sw3937
https://support.cch.com/kb/solution.aspx/sw3943
https://d2iceilwdglxpz.cloudfront.net/release_notes/CCH%20ProSystem%20fx%20Engagement%202018.2.4%20Release%20Notes.pdf
http://support.cch.com/updates/KnowledgeCoach
http://support.cch.com/updates/KnowledgeCoach
https://support.cch.com/kb/solution/000033707/sw30271
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With Accounting Research Manager, you maximize the efficiency of your research time, while enhancing your results. Learn more about our 

content, our experts, and how you can request your free trial by visiting the Accounting Research Manager Web site. You can also access 

the Accounting Research Manager Web site by selecting Engagement > Binder Window > Shortcuts Bar > Guidance tab.  

Using Your Knowledge Coach Content 

To use your Knowledge Coach workpaper templates, do the following: 

1. Open a binder in Engagement. 

2. Select the workpaper tab into which you would like to insert the workpaper. 

3. Select New Knowledge Coach Workpaper from the toolbar or File menu.  

4. Select the new Knowledge Coach title with the content you would like to use. You can only select titles you have installed. The 
information displayed changes to reflect the workpaper organization available for the selected title.  

5. Select the Knowledge Coach workpapers to insert into your binder and click OK.  

6. In the Selected Workpaper Properties window, add a workpaper index in the Index field and make any Name modifications that are 
needed. You can also modify the tab location or the roll forward settings for each workpaper. 

7. Click OK. The integrated Knowledge Coach workpaper is now inserted into your engagement binder.  

Note: For more information on how to use Knowledge Coach workpapers in your binder, see the Knowledge Coach User Guide.  

Additional Information on Knowledge Coach and the KBA Methodology 

Knowledge-Based Audit (KBA) Methodology allows the results of one set of procedures to become the input for the next. The key 

components of the KBA methodology include: 

• An overview that guides practitioners through the methodology 

• Knowledge-based attestation documents, integral to risk assessment and attestation processes, which contain steps and 
procedures required by professional standards 

• Customizable engagement programs that take practitioners through related steps and procedures 

• Practice aids to help practitioner's complete steps or processes outlined in the knowledge-based attestation documents and 
attestation programs 

• Practitioner’s reports that provide a variety of sample practitioner’s opinions on nontraditional engagements 

• Correspondence documents that provide sample letters to be used to comply with professional standards, SSAE, and SSCS 
requirements and in other common situations 

CCH® ProSystem fx® Knowledge Coach 

Knowledge Coach functionality allows practictioners to use the Knowledge-Based-Audit methodology more efficiently by eliminating the 

need for duplicate entry of the same information, tailoring engagement documentation to each particular engagement, and documenting 

the link between risks identified and procedures performed. ATT-100 Tailoring Question is a document in Knowledge Coach that presents 

engagement-level questions designed to aid in tailoring the engagement documentation to fit each client. Completing the questions helps 

the practitioner avoid duplication and unnecessary workpapers.  

http://www.accountingresearchmanager.com/
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Note: Before you begin your engagement, review the guidance in ATT-101 through ATT-116 Overall Attestation Programs. This workpaper 

is your road map through a Knowledge-Based Audit methodology. Start your engagement with ATT-100 Tailoring Question Workpaper and 

ATT-101 through ATT-116 Overall Attestation Programs. 

• Risks can be captured via the Risk Summary task pane from any Knowledge Coach workpaper by the current editor of KBA-501 
Summary of Risk Assessments. This allows you to continuously assess risks during the engagement. Several workpapers prompt you 
to consider the presence of risks, but the Risk Summary task pane must be used to document those risks. All documented risks flow 
to the Risk Summary. To ensure risks show in findings tables, select the workpaper identified in field of the Risk pane. 

• Information Flow helps reduce the time spent duplicating information across forms. In addition, the flow of consistent information 
ensures that information and updates to information are not missed between workpapers. Drill-down functionality helps the user 
navigate quickly to the source of the information, aiding in the review of the engagement file. 

• Diagnostics help track unresolved issues like unanswered questions, incomplete risks, program steps not linked to risks or relevant 
assertions, missing workpapers, and more.  

• Links to Accounting Research Manager (ARM), If you subscribe to an ARM library that includes attestation content, you can link 
directly to source material from Resources in Knowledge Coach workpapers. These links have been updated to reference the 
accounting standards under the FASB Accounting Standards Codifications and the attesation standards issued by the AICPA. Also, if 
you subscribe to the Knowledge-Based Nontraditional Engagements Guide on ARM, you can take advantage of links to the 
attestation guide material from within the Knowledge Coach documents. 

• Interpretive Guidance is integrated in each Knowledge Coach template through the Tips view of each new task pane. Informational 
features include Practice Points, Examples, Optional Workpapers, and Resources to help practitioners work more effectively and 
efficiently. You can also navigate from Resources in a document or the tip pane directly to CCH Accounting Research Manager and 
industry attestation guides by clicking on the reference.  

Download Description 2020 Knowledge-Based Nontraditional Engagements  

Version 

Engagement and Knowledge Coach v2018 with CCH ProSystem fx Engagement v2018.2.4 Update or 

later 

OR  

Engagement and Knowledge Coach v2019 or later 

2019 Financial Statement Base 

Release Date April 2020 

File size 18MB 

Approx. Download Time 42 minutes at 56 kbps 

License Full Version 

Platforms Microsoft® Windows® 8.1, Microsoft® Windows® 10 

Office Microsoft® Office 2013 or higher required 

 


